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1 SI Instructions

1.1 Software introduction

Currently there are many types of application tools required for customization development and complicated 
to install.

SyntecIDE (shortened as SI) provides friendly interface, the tools needed to open/edit different types of files 
are automatically downloaded and easy to manage for users.

In addition, developers can quickly manage different versions of the simulator, and can directly find the files 
they want to edit or view without keeping the path of file in mind.

1.2 How to download SI?

From the Syntec website to download

Path：Support > Software Download > 04.Application Tool > SyntecIDE > 1.Official Version.

1.3 Install and uninstall program

SI doesn't need to install, after decompressing, it can be executed directly. Also there is no need to uninstall it, 
just delete the folder.
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•

•

•

•

•

1.4 Precautions

If the computer has not installed the "simulator before the version 10.116.12", it may cause the 
simulator / application tool to be disabled or abnormal, Please refers to the description of "basic 
environment setting steps" below for the occurrence.

The length of the storage path for the decompressed folder cannot exceed 45 characters, and the path 
must be all English, numbers, and symbols. Therefore, it is recommended to place it in the root 
directory of any system drive.

1.5 Basic environment setting steps

Step 1: Download and install the following linked files.

LadEdit_v2.26.3.msi

Step 2: Confirm the login account, with administrator permission.

1.Control Panel → Add or remove users accounts
2.Confirm the current login account is "Administrator"
3.If the current account is not "Administrator", please log in to the administrator account.
How to activate an administrator account in Windows 8
1.Press "win + f" and enter [cmd].
2.Right click and select [Run as administrator].
3.After entering command prompt, please type [net user administrator /active:yes] and then press 
enter. 
4.If you want to deactivate administrator account, please type [net user administrator /active:no]. 
5.After activating the account, an administrator account without password will appear in the account 
management. Log in with this account.
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2 SI Function Introduction

2.1 Glossary
Title Introduction

SI Syntec IDE, IDE means Integrated Development Environment.

Project SI takes a project (simulator) as a unit. There is a DiskC folder in every project.

Project must created by SI, when you create a project, SI will download a simulator 
automatically from Syntec website, and write some necessary data into the project.

Application 
tool

Tool for viewing or editing files in the simulator, such as ladder editor, eHMI, parameter editor, 
OKLog Reader, etc.
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2.2 SI Screen Introduction

2.2.1 Main screen

1. Project title
Project name, tool name, and version

2. Function bar
The basic functions of SI

3. Project TAB
Currently we can only open one project at one time, so you can see only one TAB. Right click on it can 
select "open the directory of the project" or "close the project".

4. Back
Back to main screen, this button can be clicked in the sub-screen only.

5. Account
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If you already log in, the user's account will be displayed here. Besides, you also can log out here.

6. File information
Display all kinds of files

7. Project information
Display the project name, current version and machine type. You can also change the simulator version 
here.

8. Launch
You can launch the simulator of this project here.
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2.2.2 Sub screen

4.Back
Back to main screen.

6. File information
Display the file list of some kind you select. You can also open the corresponding tool or create a new file 
here.
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1.
2.

1.

2.
•
•
•
•

2.3 Functions

2.3.1 Create a project

There are two ways to create a project:

Execute SI and click "Create project". 
After entering the main screen, you can click "File > Project > Create Project" in the function bar, and 
then the current project will be closed.

Step：

If you are logging in SI for the first time, please input account and password. (Internet is required.)

Select the project version/Enter the project information
Select the simulator version from the pull-down menu A.
Select the machine types in software list B.
Enter the project name and file path in the C box. (You can use default path directly.)
Click D (OK button) to create a new project.
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1.
2.

1.
2.

2.3.2 Open a project

There are two ways to open a project:

Execute SI and select "Open project" to open existing projects.
After entering the main screen, you can click "File > Project > Open project" in the function bar, and 
then the current project will be closed.

Step：

Select the project name, and then press OK. (Or just double-click the project name)
Also can use “Select from other directory” to open projects stored in other path. Note that only projects 
created by SI can be opened.
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1.
2.

1.

2.3.3 Load SB file

There are two ways to load SB file:

Execute SI and select "Load SB".
After entering the main screen, you can click "File > Project > Load SB" in the function bar, and then the 
current project will be closed.

Step：

Select the SB file (.zip) and press open to load it in SI.

You can edit or view the files from SB. If you want to check the results after editing in the simulator, click 
"Launch" at right side of the screen.

When asking if you want to create a project for SB, select "Yes".

IF SI can detect the version of SB, it will select the version and machine type of the simulator automatically.

Then press "OK" and the project will be created immediately, SI will also load the project and launch simulator 
automatically.

Next time you want to edit the files of SB, you can find that project in the list.

After SB converted into a project, the following information will be copied to the project:
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•

•

1.
2.

1.

\DiskC\PrdMMIRes
\DiskC\OCRes
\DiskC\OpenCnc\Macro
\DiskC\OpenCnc\Ladder
\DiskC\OpenCnc\Res
\DiskC\OpenCnc\Data（CncBase.ini & MMIBase.ini not included）
\DiskC\OpenCnc\User﹑\DiskC2\OpenCnc\User﹑\DiskA\OpenCnc\User
\DiskC\SysData﹑\DiskC2\SysData﹑\DiskA\SysData
For some special files, such as plugin and dllaction.dll, won't be executed.

2.3.4 Load MB file

There are two ways to load MB file:

Execute SI and select "Load MB".
After entering the main screen, you can click "File > Project > Load MB" in the function bar, and then 
the current project will be closed.

Step：

Select the MB file (.zip) and press open to load it in SI.

If the MB file was made before 10.116.16F, SI may not be able to determine the version. Although the 
MB file can still be loaded, the main screen will not show the version and machine type.
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1.
2.

3.

1.
2.
3.

1.

2.

2.3.5 Change project version 

This function is used to change the machine type and version of the simulator. The customized files will still be 
retained.

Step：

Click "Change version" in the upper right corner of the main screen
Close all application tools and simulators, then press "Yes".

Select new version and machine type.
Notification：

Ladder files (.lad) in the install package will not be copied to the project.
Data files (.dat) in the install package will not be copied to the project.
If the version before 10.116.34 is upgraded to a newer version than 10.116.35, the storage path of some 
customized screen files will be automatically changed and the files will be renamed.

2.3.6 Account login/logout

After logging in, you can download the simulator and application tools

Step：

Login： Click "Login" in the upper right corner of the main screen, and enter the account and password 
applied from the Syntec website.
Logout：Click "Logout" in the upper right corner of the main screen after login.
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1.

2.

3.

a.

b.

c.
i.

ii.
iii.

2.3.7 Build installation package

After programming and testing, users can build the installation package through SI and install the package 
into the controller.

In addition, you can encrypt the files before the installation package is built. (Valid version: v1.10.0)

Step：

Click "Build install file" in the function bar.

The package name and version number are not necessary. If they are filled, they will be displayed when 
you select the installation package on the controller.

Select the contents you want to package and press OK.

If you want to encrypt the customization screen files and Macro files , check "Enable 
Encryption" and select the item you want to encrypt.
When encrypting, you can choose whether to insert the check function into all customization 
screen files. You can browse the screen on the controller when the check function conforms to 
the controller information.
There are four check functions:

Maker ID
Serial ID
Machine Type
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iv.

d.
4.

5.

1.

Model Info

Press OK to start encrypting and packaging.
When the installation package is built, the folder where the installation package is located will pop up 
automatically.

If you use encryption and enter the serial ID, this package file will store in the path: "SyntecIDE/
Packages/project name/serial ID".

Notification：

The check function only handles customization screen files (OCRes).
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1.
2.
3.

4.

2.3.8 Upgrade for customization files across 10.116.36

The customization folder (OCRes) after 10.116.36 has an structural compatibility change.

If you upgrade the controller to 10.116.36 or newer, the customization of the "standard screen" will disappear, 
and this function is required to upgrade the OCRes folder.

Steps：

Backup a MB or SB file on the controller.
Load MB or SB in SI.
Click on "Tool" > "Upgrade OCRes to 10.116.36".

Click "Upgrade for OCRes" in this window.
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5.

6.

A pop-up window indicates that the upgrade is completed. At this point, SI will continue to ask if you 
want to package it.

If it is, the package window will pop up, and OCRes will be checked by default. The package name is 
"OCRes" and the version is "10.116.36". These settings can be modified.
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7. After the package is built, the folder where the package is located will be automatically opened, and 
focus on the package created this time.

2.3.9 SB upgrade( for compatibility )
Due to the variation of hardware, specific versions of software may not function on some controllers. ( versions vary 
with hardware and time )

If a SB package of an old version can not be restored to a new device, please upgrade the SB package with this tool.

Steps：

description picture

1 Choose Non-Project Tools when opening SI

2 Click on the tool menu, select "SB upgrade"

3 Select target SB package in the dialog

4 Choose a target version to upgrade.

* version options will be the latest compatibility versions.

5 The upgraded SB package will be named as SI_SB_CRC.zip and showed in the Windows Explorer.

6 Use the package produced in step5 to restore to the new device. 無
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•

•

2.3.10 Multilingual String Import/Export 

Supported version: 1.16.0 or later

This function is used to import and export standard multiple languages into other languages.

This function will generate a specific csv file for translation agencies that are incapable of using SI or eHMI 
program.

Steps：

0：Load project

Import function is available only when the project is loaded.

1：Select a language and file to import

There is ONLY the file name of "SI_resmap_Language.csv" could be selected for importing. 
"Language" could be all supported languages.
The "Import File" field shows the absolute path.

Import Export
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•

•

•

If the selected language already exists, files with the same name as listed in SI_resmap_Lan
guage.csv will be merged. If you do not want to merge the contents of the files, please click 
"Cancel" and back up the files in advance. 

2：Importing finish

The data in SI_resmap_Language.csv will be merged with the corresponding xml file according to 
the file names.
The file location is under OCRes / Language / String.

0：Load project

Import Export
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Export function is available only when the project is loaded.

1：Select Reference Language / Export path and check the Export Options
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•
•

•

There is only standard languages in Export function currently.
"Expected Translation Language" field lists all supported languages.

After "OK" is clicked, the strings in the files listed below will be merged into SI_resmap_Language.csv 
on the basis of the settings of Export function.

1. Standard String: In StdMMIRes/Reference Language/String folder, "String_CncOps_L.xml" and 
"String_CncEngs_L.xml" files
2. Customized string: All xml files in OCRes/Reference Language/String folder

The "Language" in the exported file name stands for "Expected Translation Language".

Do NOT modify the exported file name "SI_resmap_Language.csv".
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•

•

•
•

•

If SI_resmap_Language.csv already exists under the export path, SI_resmap_Language.csv 
will be overwritten. If you do not want the files to be overwritten, please click "Cancel" and 
back up the files in advance. 

2：Exporting finish

The export folder will be opened through the file manager.

Suggestions for translation tasks:

Please use Excel for translation first, fill the translated string into the field "Translate Here", and 
make sure that the file extension is csv(Contents needs to be separated by commas) while saving 
the file.
After export, the first row of the SI_resmap_Language.csv can be edited by users.
Do NOT add rows or columns, or adjust the order of rows and columns.

Notification：

Standard parameters and alarm strings would not be exported, and multilingual translation 
is not supported.
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1.

2.

1.

2.

3.

2.3.11 Translate Help from Html

In the controller version after 10.116.36N, 10.116.44, and 10.117.44, the format and file name of the HELP file 
has changed. Therefore, Syntec IDE provides an automatic translation function.

Precautions:

To avoid file translate failure, in the HELP folder, do not put any files other than the HTML file you want 
to convert and the HELP file you have already converted.
When making an HTML file, the corresponding folder is generated with the same file name and 
extension is ".files". It cannot be stored in the HEPL folder, so it needs to be deleted. Please change 
the filename extension before deleting the folder.  Because the files are connected, when you delete 
the folder, the HTML file is also deleted.

Operation steps:

Make MB or SB backup files on the controller and load backup files on Syntec IDE. Or create/open a 
project and copy the custom file folder (OCRes) into the project
Please click "Tool > Translate Help from Html"

The controller no longer needs this HTML file
After the file has been translated, a window will pop up asking if the original HTML files should be 
deleted. It is recommended to select "Yes", avoid having too many unnecessary files stored in the 
controller.

Note: Translated files on the screen, there will be the following differences

      * The background color is fixed to blue
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1.

2.

      * Align text to the left

      * Merge or split cells are not supported

2.3.12 Search file

If the file name is known, you can find the file by searching.

Steps：

Double-click the file category icon on the main screen.

Click "Find" > "Search" in the function bar, or press "Ctrl + F". When the inquiry window appears, enter 
the file name you want to search for.
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3. After pressing OK, the found item will be automatically highlighted.
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1.

2.

2.3.13 Open the application tool

Steps：

Double-click the file category icon on the main screen. 

Double-click the file you want to open in the file list, or double-click "Double-click here to open the 
editor without opening file" to open the application tool.
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1.

2.3.14 Launch the simulator

Steps：

Double-click the "Launch simulator" icon on the right side of the SI to open the simulator.
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2.3.15 Switch language

SI supports English, Traditional Chinese and Simplified Chinese.

Steps：

1. Click the tool > Interface Language > English/Traditional Chinese/Simplified Chinese

2.The setting will take effect after restart, so you will be asked if you want to restart immediately.

3.After restart, the language will be updated.
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2.3.16 Advanced mode

You can only see two categories in General Mode of SI, they are "Interface Design" and "Machining", which are 
commonly used and suitable for developers.

In Advanced Mode, you can see other categories, such as "Operation" and "Other", this mode is suitable for 
debug.

Setting method: Click on the function bar: "Console - Advanced Mode"

Description: Tick on the left means Advanced Mode, otherwise it is General Mode

|
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2.3.17 SI automatic update

After starting SI and login, SI will check if there is a new version of SI.

When a new version is detected in Syntec website, the inquiry window will pop up to ask whether you want to 
update the version or not.

It is recommended to select "Yes".

After pressing "Yes",it will take around one minute to update the software. SI will inform you when the update 
is completed.

After pressing "Yes", SI will restart automatically.

2.3.18 Update application tool 

SI is able to automatically update application tools.

When login: When you open the application tool, SI will automatically update the tool to the latest version and 
then open it.

When not login: If SI has downloaded the latest version of the tool, SI will automatically update the tool to the 
latest version and then open it.



机床产品/Machine Tool Products  –  Syntec IDE Operation Manual.

SI Operation steps –  33

3 SI Operation steps

3.1 Customization Developers

3.1.1 Step 1: Create Project
For first use, users have to create a project or load the backup file.
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1.

2.

3.
•
•
•
•

Execute SI and click "Create project". 

For the first log in SI, please input account and password. (Internet required)

Select the project version/Enter the project information
Select the simulator version from the pull-down menu A.
Select the machine types on software list B.
Enter the project name and file path in the C box. (You can use default path directly.)
Click D (OK button) to create a new project.
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4.

1.

Import customized files(old files)
If you have customized parts of files, you can copy them into the project such as OCRes folder and 
CNC.Lad, and should be placed in the corresponding path in the DiskC folder. 
Right-click on the project TAB and click "open the directory of the project", then copy the files.

For existing projects (not the first time to use), select "Open project".

Select "Open project" to open existing projects.
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2. Select the project name, then press ok (Or double-click the project name to open the project.)
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1.

2.

3.

3.1.2 Step 2: Edit a file

EX: PLC Ladder

Double-click "ladder" icon on main screen.

SI will switch to the sub-screen and show all the files about PLC. You can double-click "cnc.lad" to edit 
the ladder and double-click "alarmplc_com.xml" to edit the PLC alarm string.

If ladder editor isn't detected in this project, SI will automatically download it from Syntec website.
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4.

5.

If you have not logged in yet, the login window will appear. Please enter your account/password.

If ladder editor exists, SI will automatically execute it and load cnc.lad file, then users can start editing.
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1.

2.

3.

EX: Customization screen

Modify standard screen

Double-click "Standard screen" icon on main screen.

Find the file you want to modify in file name list, right click and click "Copy to OCRes"

Back to the main screen.
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4.

5.

6.
7.

8.

Double-click "Custom Screen" icon.

Double-click the screen file which we just copied. 

If eHMI isn't detected in this project, SI will automatically download it from Syntec website.
If you have not logged in yet, the login window will appear. Please enter your account/password.

If eHMI exists, SI will automatically execute it and load the copied file, then users can start editing.

Add a customization screen
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1.

2.

3.

4.

5.

Double-click "Custom Screen" icon.

Double-click "Double click here to create file".

Enter a filename and press OK.

Double-click new screen file which we just created. 

If eHMI isn't detected in this project, SI will automatically download it from Syntec website.
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6.

7.

1.

2.

If you have not logged in yet, the login window will appear. Please enter your account/password.

If eHMI exists, SI will automatically execute it and load the new file, then users can start editing.
Add a fenubar (AttachFenu)

Double-click "Create fenubar" icon.

Double-click "Double click here to create file".
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3.

4.

5.
6.

7.
8.

Enter a filename and press OK.

Double-click new fenubar file which we just created. 

If eHMI isn't detected in this project, SI will automatically download it from Syntec website.
If you have not logged in yet, the login window will appear. Please enter your account/password.

If eHMI exists, SI will automatically execute it and load "test.xml" file, then users can start editing.
In eHMI, the default name of the first fenubar is "New Fenu", please modify it by yourself.

Modify a standard fenubar
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1.

2.

3.

4.

Double-click "Standard fenubar" icon.

Find the file you want to modify in file list, double-click to open it. If eHMI exists, SI will automatically 
execute it and load the file selected.

In the component browser of eHMI, find the fenubar name that you want to modify. (EX: main)

Double-click "Modify standard fenubar" icon in main screen.
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5.

6.

7.

8.

9.

Double-click "Double click here to create file".

Enter a filename and press OK.

Double-click new fenubar file which we just created. 

In the component browser of eHMI, rename "New Fenu" to which you want to modify. (EX: main)

Finish editing and save the modification.
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1.
2.

3.

4.

3.1.3 Step 3: Building installation package

On SI main screen, click "Build install file" in the function bar.
The package name and version number are not necessary. If they are filled, they will be displayed when 
you select the installation package on the controller.
Select the content you want to package and press OK.

When the installation package is built, the folder where the installation package is located will pop up 
automatically.
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1.

3.2 Problem analysis or re-development - user with SB/MB

3.2.1 Step 1: Import project

Select "Load MB" or "Load SB" 
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2. Select the MB or SB file (.zip) and press open to load it in SI.
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3. Click "Advance mode" to show the tool used for debug. 

3.2.2 Step 2: Edit a file
EX: Parameter file
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1.

2.

3.
4.

 Double-click "Parameter file" icon.

Double-click parameter file which you want to inspect or edit. (EX: param.dat)

If parameter editor isn't detected in this project, SI will automatically download it from Syntec website.
If you have not logged in yet, the login window will appear. Please enter your account/password.
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5. If parameter editor exists, SI will automatically execute it and load "param.dat" file, then users can 
start editing.
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1.
2.

3.

4.

3.2.3 Step 3: Building installation package

On SI main screen, click "Build install file" in the function bar.
The package name and version number are not necessary. If they are filled, they will be displayed when 
you select the installation package on the controller.
Select the content you want to package and press OK.

When the installation package is built, the folder where the installation package is located will pop up 
automatically.
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a.
b.
c.

4 SI Q&A

4.1 Q & A

Q1：Can SI work without internet?
SI can work without internet only when you don't need to download simulators or application tools.

When do SI need Internet:

Download the simulator to create a new project.
Download the application tools when use for the first time. (EX: Ladder editor)
Upgrade the simulator version.
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Q2：How to change the project name?
Since some functions (such as simulator, parameter editor) may be unusual in some specified path, it's 
recommended that the project must be named in English letters, numbers and symbols.

SI checks the project name after version 1.9.0 and will hint users to rename the project if the project 
name does not conform to the specification.

 

If you don't know where the project directory is, right-click on the TAB after opening the project in SI and 
select "Open the directory of the project".
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After clicking, the simulator folder will pop up, then go back to the upper level and user can find the 
project folder.

Please close SI first to avoid failure when changing name.

After changing the project name, the new project name will be displayed when restart SI.
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a.
b.

Q3：What to do if the SI doesn't work?
Please confirms that if the SI version is between 1.5.0 and 1.9.1.

If the version is within this range, SI may not be able to work normally due to the time format problems in 
different countries.

Solution：

Please download the version after 1.10.0 from Syntec website.
After confirming that SI is enabled, if you want to restore the previous projects, can follow the 
below steps:
- Copy the Project folder from the old SI folder to the new SI folder. The SI folder is named 
SyntecIDE.
- Execute SI(new version), you can select "Open project" to open the old projects.
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a.
b.

i.
1.
2.

c.

i.

ii.

iii.
d.
e.

Q4：What to do if the simulator doesn't work?
Solution：

Please follows the items mentioned in "Basic environment setting steps" in CH1.
The path of the simulator must not be too complex, have Chinese letters, or have special 
characters.

It's recommended that the total path length should not exceed 50 characters, as follows:
OK：C:\Louis\docs\woodworking\woodprj\DiskC
NG（too complex）：C:\Users\E440\Documents\Visual Studio 2013\Backup 
Files\Developer Dem

If still cannot open the simulator as a system administrator, follow these steps to set "User 
account control Settings".

Search for "UAC" in the start menu with the search box, or go to "Change User Account 
Control Settings" from the control panel.

Select minimize notification levels (Never notify).

Press OK and reboot.
Turn off the firewall
Change compatibility settings
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i.

ii.

Path: SyntecIDE → Project → Project name → DiskC → OpenCNC →  Bin →
CncMon32.exe → Property (Right click) → Compatibility → Compatibility mode / 
Settings

Click apply and OK
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Q5：After opening the simulator, the screen appears incompletely.

Solution：Control panel → Appearance and Personalization → Display, select [Smaller - 100%(default)]
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1.

Q6：How to set the simulator displaying 10+8 key?
Suitable for 10.118.12B ~ 10.118.12I

Steps：

Under the display of 8 keys, go to "Set MMIConfig" screen to set the "Window Layout Size", and set the 
width/height to 1024 and 768 respectively.
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2. Go to "Param." screen to set Pr3205 to 2 (Function key type: 10+8). Relaunch the simulator.

Remedy if setting in wrong steps:

If Pr3205 is set to 2 before "Window Layout Size" is changed on "Set MMIConfig" screen, the simulator 
may display incompletely as shown in the following figure:
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1.

2.

Solution：

Extend the window to the maximum size and try to enter "Set MMIConfig" screen to change the 
settings.
Re-download the simulator and follow the correct setting steps.
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1.
2.
3.

1.
2.
3.

Q7：After changing Pr3209, the simulator appears "路径不可为空字串或全
部空格".

Solution：Check if there is any Chinese characters in the path where the simulator is located.

Incorrect：C:\Users\SyntecClub\Desktop\模拟器_21AMill_W32_2.4.11
Correct：C:\Users\SyntecClub\Desktop\21AMill_W32_2.4.11

If the path is correct and the error window still appears, please refers to Q4.

Q8：Already logging in, but fail to download tools.
Reason：

Internet disconnection
Syntec website exception
Download function fault.

Solution：

Recover internet connection.
Contact Syntec and ask to repair the website.
Download the latest version of the tool (zip file), and put it in the path "SyntecIDE\Tool".
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5 SI Appendix

5.1 Comparison table of standard screen

After 10.116.35 and 10.117.35, the files' name of the standard screens have been changed.

For the projects with older version, if there is any customization for the standard screen, please refers to the 
following table to modify the file name.

Old filename New filename

WorkPiece.xml Brw_WorkPiece_Main.xml

SimuCoord.xml Brw_Simu_Main.xml

XML_WorkRecord.xml Brw_WorkRecord_Main.xml

SRI_Diagnostic.xml Brw_SRIDiagnostic_Main.xml

SRI_ComParam.xml Brw_SRIComParam_Main.xml

SRI_DeviceParam.xml Brw_SRIDeviceParam_Main.xml

SpindleAdjust_AccDeceleration.xml Brw_AdjustApplication_AccDec.xml

SpindleAdjust_Positioning.xml Brw_AdjustApplication_Position.xml

SpindleAdjust_Tapping.xml Brw_AdjustApplication_Tapping.xml

BallBarAdjust.xml Brw_AdjustApplication_BallBar.xml

AdjustTuningMenu.xml Brw_TuningMenu_Main.xml

AutoTuning_Home.xml Brw_AutoTune_Main.xml

AutoTuning_SetLimit.xml Brw_AutoTune_SetLimit.xml

AutoTuning_SetMode_Syntec.xml Brw_AutoTune_SynSetMode.xml

AutoTuning_Result_Syntec.xml Brw_AutoTune_SynResult.xml

AutoTuning_SPDSetMode_Syntec.xml Brw_AutoTune_SynSpdSet.xml

AutoTuning_SPDResult_Syntec.xml Brw_AutoTune_SynSpdResult.xml

AutoTuning_AdvancedMode_Syntec.xml Brw_AutoTune_SynAdvance.xml

AutoTuning_SetMode_Yaskawa.xml Brw_AutoTune_YasSetMode.xml
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AutoTuning_Result_Yaskawa.xml Brw_AutoTune_YasResult.xml

AutoTuning_SPDSetMode_Yaskawa.xml Brw_AutoTune_YasSpdSet.xml

AutoTuning_SPDResult_Yaskawa.xml Brw_AutoTune_YasSpdResult.xml

AbsoluteSetting.xml Brw_AbsoluteSetting_Main.xml

SerialServoInfo.xml Brw_SerialServoInfo_Main.xml

SerialPLCAxisParam.xml Brw_SPLCACncParam_Main.xml

SerialPLCAxisMonitor.xml Brw_SPLCADiag_Main.xml

RotParam.xml Brw_RotCncParam_Main.xml

RotMonitor.xml Brw_RotDiag_Main.xml

SysFileExportSelect.xml Brw_ExportItem_Main.xml

TableGlobal.xml Brw_Diagnostic_Main.xml

TableSysData.xml Brw_Diagnostic_SysData.xml

TableRegister.xml Brw_Diagnostic_Register.xml

TableIOCSA.xml Brw_Diagnostic_IOSCA.xml

TableTimerCounter.xml Brw_Diagnostic_TimerCounter.xml

TableCoord.xml Brw_Diagnostic_Coord.xml

TableFastSysData.xml Brw_Diagnostic_FastSysData.xml

TableFastAxiesData.xml Brw_Diagnostic_FastAxesData.xml

SimuParam.xml Brw_SimuParam_Main.xml

FeatureCoord_3PTS.xml Brw_FeatureCoordinate_3PTS.xml

FeatureCoord_TOOL.xml Brw_FeatureCoordinate_TOOL.xml

FeatureCoord_EULER.xml Brw_FeatureCoordinate_EULER.xml

FeatureCoord_2VECS.xml Brw_FeatureCoordinate_2VECS.xml

AutoCenter.xml Brw_AutoCenter_Main.xml

ManualCenter.xml Brw_AutoCenter_Manual.xml
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ThreePtsCenter.xml Brw_AutoCenter_ThreePts.xml

AutoTool4.xml Brw_AutoTool_4.xml

AutoTool.xml Brw_AutoTool_Main.xml

FavorSet.xml Brw_MyFavorite_Main.xml

SysParam.xml Brw_Param_Main.xml

SysParam_RBit.xml Brw_Param_RBit.xml

SysParam_Axes.xml Brw_Param_Axes.xml

SysParam_PitchError.xml Brw_Param_PitchError.xml

ParamSet.xml Brw_SystemSet_Main.xml

ToolMill.xml Brw_ToolMill_Main.xml

AuthoNameList.xml Brw_AuthoManager_NameList.xml

AuthoSetting.xml Brw_AuthoManager_Setting.xml

AuthoPopup.xml Brw_PopupAutho_Main.xml

ToolLathe.xml Brw_ToolLathe_Main.xml

DipoleLog.xml Brw_DipoleLog_Main.xml

SetMMIConfig.xml Brw_MMIConfig_Main.xml

NetworkSet.xml Brw_NetSet_Main.xml

CncAbout.xml Brw_CncAbout_Main.xml

RemoteConnSet.xml Brw_ClientConf_RemoteConnSet.xml

KernelParamSet.xml Brw_ServerConf_KernelParamSet.xml

BK_RT_Conclusion.xml Brw_BackUp_Std.xml

Brw_Restore_Std.xml

SysFile_I.xml Brw_MacroMgr_Import.xml

Brw_SysFileMgr_Import.xml

SysFile_E.xml Brw_MacroMgr_Export.xml
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Brw_SysFileMgr_Export.xml

SysFileTips.xml Brw_SysFileMgr_Tips.xml

SysFileImportTips.xml Brw_SysFileMgr_ImportTips.xml

CheckBootPicBMPFail.xml Brw_SelBootPic_CheckBootPicFail.xml

CheckVerFail.xml Brw_SelBootPic_CheckVerFail.xml

UpdateBootPicSuccess.xml Brw_SelBootPic_UpdateBootPicSuccess.xml

UpdateBootPicFail.xml Brw_SelBootPic_UpdateBootPicFail.xml

WorkPieceLathe.xml Brw_LatheWorkpieceShift_Std.xml

HSHPParam.xml Brw_HSHPParam_Main.xml

HSHPQuickParam.xml Brw_HSHPQuickParam_Main.xml

ToolManagement.xml Brw_ToolManagement_main.xml

SerialParamSelect.xml Brw_SerialParamMenu_main.xml

SerialTunning_Layout.xml Brw_SerialParam_main.xml

SerialTunning_Input1.xml Brw_SerialParam_Input1.xml

SerialTunning_Input2.xml Brw_SerialParam_Input2.xml

SerialTunning_Input3.xml Brw_SerialParam_Input3.xml

RestoreSerialDefault.xml Brw_SerialParamReset_main.xml

PosCoord.xml Brw_PosCoord_Main.xml

PosCoord_2.xml Brw_PosCoord_2Axes.xml

PosCoord_3.xml Brw_PosCoord_3Axes.xml

PosCoord_4.xml Brw_PosCoord_4Axes.xml

MonSTDData.xml Brw_Monitor_Main.xml

MonSTDData_Multi.xml Brw_Monitor_Multi.xml

MonSTDData_2.xml Brw_MonitorS1_Main_2Axes.xml

MonSTDData_3.xml Brw_MonitorS1_Main_3Axes.xml
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MonSTDData_4.xml Brw_MonitorS1_Main_4Axes.xml

MonGData.xml Brw_MonitorS1_GCode_Axes.xml

MonGData_2.xml Brw_MonitorS1_GCode_2Axes.xml

MonGData_3.xml Brw_MonitorS1_GCode_3Axes.xml

MonGData_4.xml Brw_MonitorS1_GCode_4Axes.xml

MonComData_2.xml Brw_MonitorS1_Com_2Axes.xml

MonComData_3.xml Brw_MonitorS1_Com_3Axes.xml

MonComData_4.xml Brw_MonitorS1_Com_4Axes.xml

ProgramEditor.xml Brw_TxtEditor_Main.xml

TeachCoord.xml Brw_TxtEditor_TeachCoord.xml

TableLogData.xml Brw_OpLogData_Main.xml

SystemInfo.xml Brw_SystemInfo_Main.xml

CncLadder.xml Brw_Ladder_Main.xml

TableToolNo.xml Brw_ToolNo_Main.xml
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